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1.  ORDERING GUIDE 

Configure a model number in this format: LW20201SG1, CBL01  

LW ........... Laureate scale / weight meter 

Display Color 

1 ............................. DPM with green LED 
2 ................................. DPM with red LED 

Power 

0 ............................................85-264 Vac 
1 ........................ 10-48 Vdc or 12-32 Vac 

Setpoint Output 

0 ..................................................... None 
1 ........................... Two 8A contact relays 
2 ............................ Two solid state relays 

Analog Output 

0 ..................................................... None 
1 .............. 4-20 mA, 0-10V, -10V to +10V 

Digital Interface 

0 ..................................................... None 
1 ................................................... RS232 
2 ................................................... RS485 
4 ..................................... RS485-Modbus 
5 ...................................................... USB 
6 ........................ USB-to-RS485 gateway 
  

 

Input Type 

Process Signals 
(4-20 mA, 0-10V, etc.) 

P ............................. 4-20 mA = 0-100.00 
P1……………. ............... Custom Scaling 

Specify min signal & reading, max signal 
& reading. 10 Vdc excitation. 

Strain Gauge, Potentiometer   
(4-wire ratio) 

SG ........................ 0-200 mV = 0-100.00 
SG1 ............... Custom Scaling 

Specify min signal & reading, max signal 
& reading. Full-scale ranges 200 mV to 
20V. 10 Vdc excitation. 

Load Cells  (6-wire ratio) 

WM1….….. ............... -99,999 to +99,999 

Specify min input & reading, max signal 
& reading. Full-scale range 20 mV to 
500 mV. 10 Vdc excitation. 
 

 
Options & Accessories 

BL ................ Blank lens, no button pads 

CBL01 ..  ....... RJ11-to-DB9 RS232 cable 
Connects meter to PC com port. 

CBL02 ..  ................ USB-to-DB9 adapter 
 ................. For use with CBL01 

CBL05 ..  ................................ USB-cable 
 ... Type A male to Type B male. 

IPC ................... NEMA-4 panel cover 
BOX1 ....  .. NEMA4 wall mount enclosure 
BOX2 ....  ......................... BOX1 plus IPC 
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3.  PRODUCT INTRODUCTION 

 

The Scale Meter is a compact, inexpensive, and extremely accurate digital panel meter with 
special firmware for weighing applications. It is available with a load cell or a DC signal condi-
tioner board.  

The load cell signal conditioner board accepts full-scale ranges of ±20, ±50, ±100, ±250 
and ±500 mV with 4 or 6-wire load cell hookup. With 4 wires, the scale meter operates in a 
ratiometric mode to eliminate errors due to power supply variations. With 6 wires, it also 
eliminates errors dues to resistance of the excitation wires, thereby allowing long cable runs in 
changing temperature environments. The built-in, isolated excitation supply can power up to 
four 350-ohm load cells in parallel at 10 Vdc.   

The DC signal conditioner board can be jumpered for ratiometric strain gauge voltage 
ranges ±200 mV, ±2V or ±20V. It can be used with a 20 mV full scale strain gauge, but that 
output will only use 10% of the meter’s most sensitive range. 

Meter accuracy is 0.01% of full scale ± 2 counts. Custom curve linearization, available with an 
optional Extended main board, can extend the accuracy of actual load cells near the low and 
high ends of their ranges. It also allows high accuracy readings to be achieved with lower cost, 
less linear load cells.  

The standard power supply is a switching model designed for universal AC power. A low-
voltage supply is optional for power from 10-48V batteries or from 12-30 Vac. Both supplies 
provide an isolated 5, 10 or 24Vdc transducer excitation output.  

The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 UL-
rated plastic and is watertight to NEMA-4 (IP65) when panel mounted. Mounting is from the 
front of the panel and requires less than 110 mm behind the panel. Power and signal wiring is 
via removable plugs conforming to UL61010C safety standards. All output options are isolated 
from meter and power ground to 250 Vac. 

Alarm or setpoint control is provided by an optional relay board with two Form C 8A contact 
relays or two Form A 130 mA solid state relays. The setpoints may be latching or non-latching, 
be energized above or below the setpoint, or operate in a fail-safe mode. The relays can 
operate from the filtered signal to reduce relay chatter or from the unfiltered signal for fastest 
response. Snubber circuits and a programmable relay switching time delay extend relay 
contact life. 

An isolated analog output of 4-20 mA, 0-20 mA, 0-10V or -10 to +10V can be provided by an 
optional analog output board. The output is linearized to the display and can operate from the 
filtered or unfiltered signal input. It can be scaled via front panel pushbuttons or the meter’s 
serial interface.   

USB, RS232 or RS485 (2-wire half-duplex or 4-wire full-duplex) serial communications options 
are available with the Modbus RTU protocol or a simpler custom ASCII protocol. Modbus 
operation allows up to 247 digital addresses. Up 32 devices can be connected to an RS485 
line without a repeater. A USB-to-RS485 gateway boards allow a meter to be interfaced to a 
PC and to multiple meters on an RS485 network. Ethernet communications are not supported 
by the scale meter, but are supported by the closely related Laureate load cell meter. 

Scale meter programming can be via the meter’s front panel or a PC running Windows 
based Instrument Setup Software (serial interface option required). 
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4.  ADVANCED OPERATING FEATURES   

 Setpoint offset. The ON/OFF setpoint control action can be programmed to occur with a 
specified offset. For instance, if bags are to be filled to 100 lbs and the material delivery 
spout is known to hold and dispense an additional 2.5 lbs following shut-off, an offset of -2.5 
lbs can be programmed. The setpoint can then be set to 100 lbs, and the filling valve will be 
automatically shut off when the measured weight reaches 97.5 lbs. 

 Dribble factor. On/off setpoint control action can be programmed to occur with a specified 
offset. For instance, if bags are to be filled to 100 lbs and the material delivery spout is 
known to hold and dispense an additional 2.5 lbs following shut-off, an offset of -2.5 lbs can 
be programmed. The setpoint can then be set to 100 lbs, and the filling valve will be 
automatically shut off when the measured weight reaches 97.5 lbs. 

 Count-by function. The weight meter can be programmed so that the display is rounded off 
to multiples of 1, 2, 5, 10, 20, 50, 100, 200, 500 or 1000. For example, if count-by 10 is 
selected, the meter will display 20 for an internal count of 15 to 24. 

 Fixed dummy right-hand zero. The display can be shifted to the left for a fixed zero to the 
right, allowing values up to 999,990 to be displayed. This removes the ability to have 
decimal points. 

 Auto-zero function. An auto-zero limit from 0 to 9 counts can be programmed to compen-
sate for load cell drift. Whenever the meter comes to rest within that limit from zero, it will 
auto-zero. It will auto-tare to display zero with a slowly drifting input. Entering 0 disables 
auto-zero. 

Two tare functions: auto-tare and manual tare. In auto-tare, a control input line is grounded 
by an external pushbutton. This causes the current weight, which is normally the empty weight 
of the container to be stored in memory as an offset. In manual tare, the tare value can be 
entered manually via the front panel or a computer. For instance, the tare value may be the 
stated empty weight of a truck or rail car. Pressing the Reset button on the front panel toggles 
the display between gross weight (total weight on the scale) and net weight (gross weight with 
tare subtracted). 
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5.  RECEIVING & UNPACKING 

 
Your scale meter was carefully tested and inspected prior to shipment. Should the meter be 
damaged in shipment, notify the freight carrier immediately. In the event the meter is not 
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or 
replacement. Please include a detailed description of the problem. 

 

6.  SAFETY CONSIDERATIONS 

 
 

 Warning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of 
damage.  If the unit is damaged, do not attempt to operate. 

Caution:  

 This unit must be powered with AC (mains) from 85-264 Vac with the high voltage power 
supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power supply option. Verify 
that the proper power option is installed for the power to be used. This meter has no AC 
(mains) switch. It will be in operation as soon as power is connected. 

 The 85-264 Vac mains connector (P1 Pins 1-3) is colored Green to differentiate it from 
other input and output connectors. The 12-32 Vac (10-48 Vdc) mains connector is colored 
Black. 

 Do not make signal wiring changes or connections when power is applied to the instrument. 
Make signal connections before power is applied. If reconnection is required, disconnect 
the AC (mains) power before such wiring is attempted.   

 To prevent electrical or fire hazard, do not expose the instrument to excessive moisture. 

 Do not operate the instrument in the presence of flammable gases or fumes; such an 
environment constitutes a definite safety hazard. This meter is designed to be mounted in a 
metal panel.   

 Verify the panel cutout dimensions, and mount according to instructions. 
 
Symbols used 
 

 
Caution (refer to accompanying documents) 

 
Earth (ground) terminal. 

 

 
Caution, risk of electric shock.  Both direct and alternating current. 

 
Equipment protected throughout by double 
insulation or reinforced insulation. 

  

 
Operating environment: 

The meter is Class II (double insulated) equipment designed for use in Pollution degree 2. 
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7.  CONNECTOR WIRING INFORMATION 

 
CONNECTORS 

Connectors for signal and power are UL-rated 
screw-clamp terminal blocks that plug into 
mating jacks on the printed circuit board. 
Communication connectors are a single RJ11 
plug for RS232, dual RJ11 plugs for RS485, 
dual RJ45 plugs for RS485 Modbus, or USB. 

 
  
 

Warning:  Hazardous voltages may be present on pins 4, 5 & 6 of P1 since digital ground is 
tied to pin 3 of P5 (-Signal Input). Keep pin 3 close to earth ground to minimize common mode 
voltage or shock hazard at pins 4, 5 & 6 of P1. 

P5 – SIGNAL INPUT 

 

 

 

Excitation voltage can be jumpered for 5, 10 or 24 Vdc (Section 17).

* Control inputs 1 & 2 of P1 are menu 
  selectable. 
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The analog output is sourcing. Do not put an external voltage source in series. 
Applying an external 24 Vdc source will burn out the analog output board. 

P3 - SERIAL COMMUNICATIONS   P4 - ANALOG OUTPUT 
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8.  MECHANICAL ASSEMBLY 

 
REMOVING THE REAR PANEL 

First remove any connectors. Use one hand to press in the two sides of the rear of the 
case, and the other hand to press down the two protruding tab releases at the top of the 
rear panel (see figure below). This will unhook the rear panel from the case. 

 

 
Rear Panel 

REMOVING THE ELECTRONICS & INSTALLING OPTION BOARDS 

With the rear panel removed, the 
electronic assembly will easily slide 
out through the rear of the case. 

Options boards plug into the main 
board at the front of the meter. 
These are plug-and-play and may 
be installed in the field. New 
boards will be recognized by the 
meter software for access to the 
appropriate menu items. You may 
need to remove rear panel knock-
outs to fit new boards.  

Note: When an option board is installed correctly, the top and bottom edges of the main 
board and option board are aligned. Misaligned boards will burn out the electronics. 

 

Option Board Main Board Plug Rear Panel Jack 

Power supply 
Relay board 
Serial interface board 
Analog output board 
Signal conditioner board 

P11 
P12 
P13 
P14 
P15 

J1 
J2 
J3 
J4 
J5 

 
REASSEMBLING YOUR METER 

Slide the electronics assembly back into the case until the display board is seated flush 
against the front of the case. Insert the bottom tabs of the rear panel into the case, and then 
carefully align the board connectors with the openings in the rear panel. Ensure that all 
option boards are properly aligned with the molded board retaining pins on the inside of the 

Retaining tab 
with tab release 

Retaining tab
with tab release

Retaining tab
Retaining tab 
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rear panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal 
plugs. 
 

PANEL MOUNTING  

Slide the meter into the 45 x 92 mm 1/8 DIN panel cutout. 
Ensure that the provided gasket is in place between the 
front of the panel and the back of the meter bezel.  

The meter is secured by two pawls, each held by a screw. 
Turning a screw clockwise extends the pawl outward. 
Turning the screw clockwise further tightens it against the 
panel to secure the meter.  

Turning a screw counterclockwise loosens the pawl and 
retracts it into its well. This allows the meter to be inserted 
into the panel cutout for installation, or to be removed from  
the panel cutout following installation. 

Note: In no case should a screw be removed from its pawl. Doing so would cause the screw 
and pawl to fall off and likely get lost. 

 
 

 
 

Dimensioned case drawings 
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9.  FRONT PANEL SETUP KEYS 

 

 

Meter Front Panel 

There are four front panel keys, which change function for the Run Mode and Menu Mode, 
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU, 
PEAK, RESET, ALARMS) for the Run Mode and with symbols (  right arrow, 

 right triangle,  up triangle,   left arrow) for the Menu Mode. 

FRONT PANEL LOCKOUT 

The Menu Mode will not work with most meters as received from the factory, since all menu 
items have been disabled in software and a lockout jumper is in place. That jumper needs to 
be removed for the Menu Mode to work, and menu items under Loc 1, Loc 2 and Loc 3 then 
need to be set to "0" via the front panel for these menu items to be unlocked See Section 
10. The paragraphs below assume that all menu items have been unlocked. 

MENU MODE KEY ACTION 

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding 
down a key automatically advances through multiple menu items for fast menu navigation. 

KEYS IN RUN MODE 

MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing 
MENU repeatedly will step the meter through the various menu items (if these have not 
been locked out) and then back to the Run Mode.    

PEAK Key.  Pressing PEAK normally causes the peak value of the input signal to be 
displayed. The peak display then blinks to differentiate it from the normal present value 
display. Pressing PEAK again returns the display to the present value. The PEAK key 
can also be programmed to display Valley, alternating Peak or Valley, or to Tare the 
reading to zero. When Peak or Valley is selected, periodic horizontals bars at the top of 
the display indicate Peak, and periodic horizontals bars at the bottom indicate Valley. 

RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing 
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a 
meter reset (same as power on). Meter reset can also be applied via a rear panel 
connect or a serial ASCII command. 

ALARMS Key.  Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it 
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.   
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KEYS IN MENU MODE 
 
Right Arrow Key (MENU).  Pressing  steps the meter through all menu items that 
have been enabled and then back to the Run Mode. With the DC signal conditioner 
board and no option boards, available menu items are _InPut, SEtuP, ConFG, _FiLtr, 
dEc.Pt, SCALE, OFFst, Loc 1, Loc 2, Loc 3. If a change has been made to a menu 
item, that change is saved to non-volatile memory when the  key is pressed next, 
and StoreE is displayed briefly.  
 
Right Triangle Key (Digit Select). 

 Pressing  from the InPut menu brings up all meter functions available with the 
meter's signal conditioner. For the DC signal conditioner, these are _dC U, _dC A 
and _rAtio. 

 Pressing  from the SEtuP, ConfFG, FiLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3 
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit: 
00000, 00000, 00000, 00000, 00000. 

 Pressing  from the dEC.Pt menu item sequentially selects decimal point positions, 

which will flash: d.dddd  dd.ddd  ddd.dd  dddd.d  ddddd.  .ddddd. 

 
Up Triangle Key (Value Select).  Pressing  for a flashing item (digit position or 
decimal point position) will increment that item. Pressing MENU will save any changes. 
 
Left Arrow Key (Reverse Menu).  Pressing  has the same effect as the MENU key, 
except that menu items are brought up in reverse order. 
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10.  ENABLING & LOCKING OUT MENU ITEMS 

 
For security reasons and ease of meter operation, any or all menu 
items may be disabled or "locked out" so that they are no longer 
accessible from the front panel. Each function to be disabled can be 
set to "1" under menu headers Loc 1-4, while each function to be 
enabled can be set to "0." Access to the menu headers Loc 1-4 can in 
turn be locked out by installing a hardware jumper on the power 
supply board. With the jumper installed, the operator only has access 
to previously enable menu items, not to the menu headers Loc 1-4 
and hence not to the menu items below. With the jumper removed, 
the operator has access to menu headers Loc 1-4 and hence to the 
menu items below. 

SETTING THE HARDWARE LOCKOUT JUMPER 

To access the lockout jumper, remove the rear panel per Section 
10 and locate jumper “a” in the lower portion of the power supply 
board next to the input connectors (see figure). 

SETTING SOFTWARE LOCKOUTS  

Set the lockout digit to "1" if you do not want the 
menu item to be changed by an operator, other-
wise to “0”. 

 

Loc 1   Loc 2   Loc 3   Loc 4    

Press the  MENU key until Loc 1, Loc 2, Loc 3 
or Loc 4 is displayed. Note: hardware lockout 
jumper “a” must be removed (see above). 
 
00000 
12345 

Press  to set the flashing digit to "0" to enable the 
menu item or to "1" to disable. Press MENU to 
enter. See the table to the right for the list of menu 
items that can be enabled or disabled. 

 
11111 

Press  to display the lockout status, consisting of 
1’s and 0’s. The left digit will flash. Press  again 
to step to the next digit, which will flash.  

 

Lockout Digits for Menu Items 

Loc 1 

2 – Net/Gross display (reset key) 
3 – Input type selection 
4 – Setup, config. & decimal point 
5 – Count-by and auto-zero 

Loc 2   

2 – Filtering 
3 – Scale, Lo In, Hi In 
4 – Offset, Lo Rd, Hi Rd 
5 – Tare 

Loc 3    

2 – Alarm setup 
3 – Change alarm setpoints 
4 – Analog output scaling 
5 – Serial comm. config. 

Loc 4    

2 – View peak value 
3 – View alarm setpoints 
4 – Front panel function resets 
5 – Front panel meter reset 
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11.  PROCESS & STRAIN INPUT JUMPERS 

 
Process and strain input scale meters utilize the DC signal conditioner board, which offers 
sensitivity to ±200 mV and can operate in a ratiometric mode, which removes effects caused 
by variations in the excitation supply. This board needs to be configured via jumpers for the 
desired voltage or current range. All signal ranges are factory calibrated with calibration factors 
stored in EEPROM. The meter software recognizes the board and will bring up the appropriate 
menu items for it; however, it does not recognize the jumper settings. Please see further 
manual sections for relay output, analog output, communications, and transducer excitation 
output. 
 
RANGE SELECTION VIA JUMPERS 
 

1. Letters indicate jumper position.  Jumpers are installed on pins adjacent to letters. 
2. Use 5 mm (0.2") jumpers for locations designated by a capital letter. 
3. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter. 
4. Store spare jumpers on an unused jumper post not associated with a capital letter. 
 
SCALE & OFFSET SETUP 

For process, strain, and load cell scale meters, scaling is normally set up from the front panel 
using the  and  keys, but can also be set up via RS232/485 using PC-compatible 
Instrument Setup software (available at no charge). The meter allows three scaling methods to 
be selected: 1) Scale & Offset method, 2) Coordinates of 2 Points method, or 3) Reading 
Coordinates of 2 Points method. Only menu items applicable to the selected method will be 
presented. Please see the Glossary for an explanation of each method.  
 
 
 
 

Voltage Ranges              Jumpers 

E1

a

E2

b

E3

h
a

g

e d

c

bf

B

A

 

FS Input E1 E2 E3 

±200.00 mV 
±2.0000 V 
±20.000 V 
±200.00 V 
±300V (UL) 
±600V (not UL) 

A 
A 
B 
B 
B 
B 

f 
f 
h 
h 
g 
g 

b 
a 
b 
a 
a 
a 

Current Ranges              Jumpers 

FS Input E1 E2 E3 

±2.0000 mA 
±20.000 mA 
±200.00 mA 
±5.000 A 

A 
A 
A 
A 

e, g 
d, g 
c, g 

a, b, g 

b 
b 
b 
b 
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12.  LOAD CELL INPUT JUMPERS 

 
 
 
 
 
 
 
 
 
 
 
 

Notes 1. See Section 17 to select 10V excitation. 
2. Jumpers are 2.5 mm (0.1 in). 
3. Store spare jumpers on an unused jumper post. 

 
SCALE & OFFSET SETUP 

For load cell scale meters, scaling is normally set up from the front panel using the  and  
keys, but can also be set up via RS232/485 using special PC-compatible Instrument Setup 
software (available at no charge). The meter allows three scaling methods to be selected:  
1) Scale & Offset method, 2) Coordinates of 2 Points method, or 3) Reading Coordinates of  
2 Points method. Only menu items applicable to the selected method will be presented. Please 
see the Glossary for an explanation of each method. 

 
Load cell scale meters utilize the load cell signal conditioner board, which offers sensitivity to 
±20 mV full scale and 4- or 6-wire load cell connection. This board needs to be configured via 
jumpers for the desired voltage range. All signal ranges are factory calibrated with calibration 
factors stored in EEPROM. The meter software recognizes the board and will bring up the 
appropriate menu items for it; however, it does not recognize the jumper settings. Please see 
further manual sections for relay output, analog output, communications, and transducer 
excitation output. 

RANGE SELECTION VIA JUMPERS 
 

Ranges & Display with  
Scale Factor = 1 

Input Jumpers 
Full scale 
display 

±20 mV 
±50 mV 

±100 mV 
±250 mV 
±500 mV 

e 
a 
b 
c 
d 

±20000 
±50000 
±10000 
±25000 
±50000 
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13.  SCALE METER SETUP 

 
When the Reading Coordinates of 2 Points scaling method is selected under ConFG, the 
four menu items below will appear ahead of all other menu items when the MENU or  
key is first pressed from the run mode. This scaling method applies a straight line fit 
between two points, which are determined from actual transducer signals and the desired 
corresponding meter readings. A low signal, such as the output of a load cell at zero weight, 
and a high signal, such as the output of the same load cell at a known high weight, are 
applied to the meter. The desired corresponding low and high readings are then entered 
from the front panel. The meter then applies straight line fit between the high and low 
calibration points. This scaling method has the advantage of calibrating the transducer and 
meter as a system. The actual voltage or current at either point does not need to be known. 
This method is ideal for process and load cell scale meters, which require zero and span 
adjustment. 

The other two scaling methods, namely scale and offset method and coordinates of 2 points 
method, are selectable under SEtuP when ConFG, digit 2 is set to 0. 

The programming example below is for Reading Coordinates of 2 Points scaling for a scale 
meter used with a 4-20 mA load cell transducer for 0-100 lbs. Decimal points are set 
separately using the dEC.Pt menu. 

 

  

Press Menu Select 
Key 

 
  

Press Digit Select 
Key 

 
  

Press Value Select 
Key 

 

Lo In  Apply low signal input 
(e.g., transducer output for 0 
psi). 

_40.21  Press  to display 
reading at low signal input 
(e.g., 4.021 mA). 

_40.21  Press  to store low 
reading. 

Hi  In Apply high signal input 
(e.g., transducer output for 
known 100.00 psi source). 

200.94  Press  to display 
reading at high signal input 
(e.g., 20.094 mA). 

200.94  Press  to store high 
reading. 

Lo rd 
Mode to enter desired low 
reading (e.g., 0.00). 

000.00  000.00  000.00 

000.00  000.00  Select digit 
to flash. 

100.00  Select -9 thru 9 for 
flashing first digit, 0 thru 9 for 
other flashing digits. 

Hi  rd 
Mode to enter desired high 
reading (e.g., 100.00). 

000.00  000.00  000.00 

000.00  000.00  Select digit 
to flash. 

100.00  Select -9 thru 9 for 
flashing first digit, 0 thru 9 for 
other flashing digits. 
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OTHER KEYSTROKES FOR SCALE METER SETUP 
**If the MENU    key does not work, see Section 10 “Enabling & Locking Out Menu Items.” 
 

  

Press Menu 
Select Key 

 
  

Press Digit 
Select Key 

 
  

Press Value Select  
Key 

 

_InPut 
DC signal condi-
tioner board 

_dC U 
DC Volts 

__0.2U  __2.0U  _20.0U  200.0U  600.0U  
0.2, 2, 20, 200, 660V FS 

_dC A 
DC Amps 

__2.0A  _20.0A  _200.0A  _5.0A 
0.2, 20, 200 mA, 5A FS 

_rAtio 
Strain gauge & ratio 

__0.2U  __2.0U  _20.0U   
0.2, 2, 20V FS. 

_InPut 
Load cell signal 
conditioner board 

_Strn 
Strain or ratiometric 

_20.0____50.0_  _100.0  _250.0  _500.0  
20, 50, 100, 250, 500 mV FS voltage 

_dC u U 
DC millivolts 

_20.0____50.0_  _100.0  _250.0  _500.0  
20, 50, 100, 250, 500 mV FS voltage 

SEtuP  
Meter Setup 

00000   
Dummy right-hand 
zero for large numbers 

0   No dummy zero (display to 99999) 
1   Dummy zero (display to 999990) 
 (removes decimal points) 

00000   
Power line frequency 

0   Noise minimized for 60 Hz 
1   Noise minimized for 50 Hz 

00000   
Peak Key Action 

0   Display peak 
1   Tare action 

00000   
Scaling method 

0   Scale and offset method 
1   Coordinates of 2 points method 
Reading Coordinates of 2 points method is 
selected by ConFG digit 2. 

00000   
Control inputs 1 & 2  
or both: 

True = logic 1 (0V or 
tied to digital ground) 

False = logic 0 (5V or 
open) 

     Input 1 Input 2  Both 1 & 2 
0   Meter Reset Meter Hold  Meter Reset 
1   Funct Reset  Peak Displ Meter Reset 
2   Meter Hold Peak Displ Funct Reset 
3   Meter Hold  Tare Action Tare Action 
4   Peak Disp Tare Action Funct Reset 
5   Meter Reset Tare Action Meter Reset 
6   Funct Reset Tare Action  Meter Reset 
7   Tare Reset Tare Action Meter Reset 
8   Displ Blank Tare Action  Meter Reset 
9   Meter Reset Displ Blank Meter Reset 
A  Funct Reset  Displ Blank Meter Reset 
B  Displ Item  Tare Action Tare Action 
C  Displ Item  Displ Blank Funct Reset 
D  Meter Reset Displ Item Meter Reset 
E  Funct Reset Displ Item Meter Reset 
F  Meter Hold Displ Item Meter Reset 
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Press Menu 
Select Key 

 
  

Press Digit 
Select Key 

 
  

Press Value Select  
Key 

 

ConFG  
Meter Configuration 

00000 
Negative readings 

0   Allow negative readings 
1   Disallow negative readings 

00000 
Setup method 

0   Setup method selected by SEtuP, digit 4 
1   Reading coordinates of 2 points method 

00000 
Dribble function 

0   Dribble enabled 
1   Dribble disabled 

00000 
Peak key action 

0   Peak of net value 
1   Peak of Gross value 

00000 
Adaptive filtering 

0   Enable adaptive filtering 
1   Disable adaptive filtering 

Count  
Count-by or  
Auto-zero function 

00000 
Count by  
(see Glossary) 

0   Count by 1 5   Count by 50 
1   Count by 2 6   Count by 100 
2   Count by 5  7   Count by 200 
3   Count by 10 8   Count by 500 
4   Count by 20 9   Count by 1000 

00000 
Auto-zero 
(see Glossary) 

0   No auto-zero 5   ± 1 count   
1   ± 2 counts  6   ± 3 counts 
2   ± 4 counts  7   ± 5 counts 
3   ± 6 counts 7   ± 7 counts 
4   ± 8 counts 9   ± 9 counts 

FiLtr  
Filtering 

00000   
Alarm filtering 

0   Unfiltered output 
1   Filtered output 

00000   
Peak & Valley filtering 

0   Unfiltered Peak & Valley 
1   Filtered Peak & Valley 

00000   
Display filtering 

0   Display batch average every 16 readings 
1   Display filtered signal 

00000  Adaptive filter 
threshold 

0   Low adaptive filter threshold level 
1   High adaptive filter threshold level 
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FiLtr  
Filtering 
(continued) 

00000   
Input signal filtering. 
Can be applied to dis-
play, setpoint, analog 
output, data output. 
 

0   Autofilter     Readings  
1   Batch avg  16 60 Hz  50 Hz 
2   Moving avg     . 07 s   .08 s 
3   Moving avg      .14   .16 
4   Moving avg    .28   .34 
5   Moving avg    .57   .68 
6   Moving avg          1.13    1.36 
7   Moving avg               2.27    2.72 
8   Moving avg               4.53    5.44 
9   Moving avg               9.06  10.88 
A  Moving avg              18.1    21.7 
B  Moving avg              36.2    43.4 
C  Moving avg              72.5       85 
D  Moving avg              145     174 
E  Moving avg              290     348 
F  No filter              

dEc.Pt   
Not for dummy zero 

d.dddd 

Decimal point flashes.  

d.dddd  dd.ddd  ddd.dd  dddd.d  ddddd.  

.ddddd  Press  to shift the decimal point. 

Scaling method “Scale and Offset” if selected under SEtuP  

SCALE  
Scale factor 

0.0000  0.0000  0.0000 

0.0000  0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Select decimal point 
location when decimal point is flashing. 

OFFst  
Offset value 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Decimal point 
location is selected by dEC.Pt. 

Scaling method “Coordinates of 2 points” if selected under SEtuP. Appears before _InPut. 

Lo In.   
Low signal input. 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Decimal point is set 
by input range chosen. 

Lo rd   
Desired reading at 
Lo In. 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Decimal point is set 
by dEC.Pt. 

Hi In.   
High signal input. 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Decimal point is set 
by input range chosen. 

Hi rd.   
Desired reading at 
Hi In. 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Decimal point is set 
by dEC.Pt. 

_tArE  
Tare value 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Decimal point 
location is selected by dEC.Pt. 
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Option board dependent menu items 

ALSEt. -SP1-d -SP2-d       
Menu items related to alarm setup These will only appear if a relay board is detected. If so, 
please see Section 14. 

AnSEt. An Lo. An Hi..   

Menu items related to analog output setup. These will only appear if an analog output 
board is detected. If so, see Section 15. 

SEr 1. SEr 2. SEr 3. SEr 4. _Addr  
Menu items related to serial communications. These will only appear if an RS232 or 
RS485 I/O board is detected. If so, see Section 16.  

Menu lockout items 

Loc 1. Loc 2. Loc 3. Loc 4. 

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn 
be locked out by a hardware jumper. Please see Section 10. 

 
*  Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all 

other Menu items, including _InPut. Decimal point is set by dEC.Pt. 
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14.  DUAL RELAY OUTPUT OPTION  

An optional relay board may be installed in the 
scale meter main board at plug position P2, 
adjacent to the power supply board. This board 
is available in two versions: 2 mechanical relays 
or 2 solid state relays. Once installed, the relay 
board is recognized by the meter software and 
PC-based Instrument Setup software, which will 
bring up the appropriate menu items for the 
board type. These menu items will only be 
brought up if a relay board is detected. Both 
relay boards offer a choice of operating modes: 
Off or On in alarm mode; latched or non-latched; alarm high, low or disabled; alarms on net or 
gross weight; and time delay to alarm.  

KEYSTROKES FOR SETPOINT SETUP  
If the MENU    key does not work, see Section 10 “Enabling & Locking Out Menu Items.” 
 

  

Press Menu 
Select Key 

 
  

Press Digit 
Select Key 

 
  

Press Value Select  
Key 

 

ALSEt 
Alarm Setup for 
relays 1 & 2 if 
detected. 

Press  until 
ALSEt is displayed. 

  00000 
Relay state when 
alarm is active. 

0   Relay 1 On  Relay 2 On 
1   Relay 1 Off Relay 2 On 
2   Relay 1 On  Relay 2 Off 
3   Relay 1 Off Relay 2 Off 

  00000 
Alarm latching or non-
latching. 

0   AL1 non-latching  AL2 non-latching 
1   AL1 latching  AL2 non-latching 
2   AL1 non-latching  AL2 latching 
3   AL1 latching  AL2 latching 

  00000 
Alarms high, low, or 
disabled. 

0   AL1 hi active  AL2 hi active 
1   AL1 lo active  AL2 hi active 
2   AL1 disabled  AL2 hi active 
3   AL1 hi active  AL2 lo active 
4   AL1 lo active  AL2 lo active 
5   AL1 disabled  AL2 lo active 
6   AL1 hi active  AL2 disabled 
7   AL1 lo active  AL2 disabled 
8   AL1 disabled  AL2 disabled 

  00000 
Alarms comparison on 
gross or net weight 

0   AL1 net   AL2 net 
1   AL1 gross   AL2 net 
2   AL1 net   AL2 gross 
3   AL1 gross   AL2 gross 
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  00000 
Number of consecutive 
readings in alarm zone 
to cause an alarm. 

0   After 1 reading  4   After 16 readings 
1   After 2 readings  5   After 32 readings 
2   After 4 readings  6   After 64 readings 
3   After 8 readings  7   After 128 reading 

  

Press Menu 
Select Key 

 

  

Press Digit 
Select Key 

 

  

Press Value Select  
Key 

 

_SPI_d 
Alarm 1 dribble 
value 

0.0000  0.0000 0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first digit, 0 thru 9 
for other flashing digits. Active high alarms 
will activate above the setpoint (positive 
dribble value) or below the setpoint (negative 
dribble value). 

_SP2_d 
Alarm 2 dribble 
value 

0.0000  0.0000 0.0000 

0.0000  0.0000 

Select digit to flash. 

 

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS 

The  (Alarms) key can be used to step through and view setpoints while the meter conti-
nues to make conversions and performs setpoint control. If the  (Peak) key is pressed while 
a setpoint is displayed, conversion stops and the setpoint can be changed. After pressing , 
you have 30 seconds, or the meter will revert to the normal display. To view setpoints, menu 
item Loc3, digit 3, must have been set to 0. To change setpoints, menu item Loc4, digit 3, must 
have been set to 0.  

  

Press Alarms  
Key 

 
  

Press Digit 
Select Key 

 
  

Press Value Select  
Key 

 

300.24 
Press  (Alarms)  
to display Alarm 1 
setpoint. 

_200.00 
Current setpoint 1 digit blinks, and 
Alarm 1 LED indicator lights. Press  
to select another digit, which will blink. 

_295.00 
To change setpoint 1 value, 
press  to change the 
selected blinking digit value. 

395.00 
Press  (Alarms)  
to display Alarm 2 
setpoint.  

_395.00 
Current setpoint 2 digit blinks, and 
Alarm 2 LED indicator lights. Press  
to select another digit, which will blink. 

_305.00 
To change setpoint 2 value, 
press  to change the 
selected blinking digit value. 

300.24   Press  (Alarms) again. Meter will reset and display current reading. 
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ALARM TYPES 
 

 
 
Latched alarms stay actuated until reset. They can shut down machinery or a process when a 
setpoint (or limit) has been exceeded or maintain an alarm condition until acknowledged by an 
operator. 

Non-latched alarms change state automatically when a reading rises above a setpoint and 
change back automatically when the reading falls below that setpoint. 

Dribble is a settable scale meter parameter in counts which allows a flow to be shut off before 
the setpoint value has been reached. For example, set the setpoint to 100.0 (1000 counts) and 
the dribble factor to -50 counts to turn off the fill of a 100.0 lb bag at 95.0 lbs if the shut-off 
system is known to dribble another 5.0 lbs following shut-off. 
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15.  ANALOG OUTPUT OPTION 

 
An analog board may be installed in the meter at rear panel jack position J4, adjacent to the 
signal conditioner board. Once installed, this board is recognized by the meter, which will bring 
up the appropriate menu items for it. These will not be brought up if an analog output board is 
not installed.  

The analog output can be a 0-20 mA, 4-20 mA or 0-10V unipolar signal with respect to isolated 
ground, or a bipolar -10V to +10V voltage signal with respect to a reference return line. 
Unipolar or bipolar operation is selected by a jumper. A unipolar current or voltage output is 
selected at the connector.  Unipolar 4-20 mA or 0-20 mA current is selected in software. 
 

 

Unipolar current or voltage: Jumper a 

Bipolar -10 to +10 voltage: Jumper b 

 
The low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low 
displayed reading An Lo. The high analog output (20 mA, 0V or 10V) may be set to corres-
pond to any high displayed reading An Hi. The meter will then apply a straight line fit between 
these two end points to provide an analog output scaled to the meter reading. 

KEYSTROKES FOR SETUP 
If the MENU    key does not work, see Section 10 “Enabling & Locking Out Menu Items.” 

  

Press Menu 
Select Key 

 
  

Press Digit Select 
Key 

 
  

Press Value Select  
Key 

 

AnSEt 
Analog Output Setup. 
Press  until AnSEt 
is displayed (requires 
analog output board). 

___00 
Analog output signal 
selection. 

0   0-20 mA current output 
1   0-10V voltage output 
2   4-20 mA current output 
3   -10 to +10V voltage output 

___00 
Analog output source. 

0   Net filtered 
1   Gross filtered 
2   Net unfiltered 
3   Gross unfiltered 

An Lo 
Low displayed value 
for 0 mA, 4 mA, 0V, or 
-10V output 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first 
digit, 0 thru 9 for other flashing 
digits. Decimal point location is 
fixed by dEC.Pt selection. 

An Hi. 
High displayed value 
for 20 mA or 10V out-
put 

0.0000  0.0000  0.0000 

0.0000  0.0000 

Select digit to flash. 

Select -9 thru 9 for flashing first 
digit, 0 thru 9 for other flashing 
digits. Decimal point location is 
fixed by dEC.Pt selection. 
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16.  SERIAL COMMUNICATION OPTIONS 

 
A serial communications board may be connected to the meter main board at plug position 
P13 (middle position). Available boards are RS232, RS485 (with dual RJ11 connectors), 
RS485 Modbus (with dual RJ45 connectors), USB, and a USB-to-RS485 gateway. The dual 
connectors of RS485 boards are wired in parallel to allow daisy chaining of addressable 
meters without use of a hub. Two serial communication protocols are selectable for all serial 
boards: the Custom ASCII protocol, and the Modbus RTU protocol.  

To connect a meter with a USB board to a computer, use a USB cable with Type A and 
Type B connectors. The computer will display “Found new Hardware” followed by “Welcome to 
the Found new Hardware Wizard.” Follow the instructions for software installation from a CD. 
When the installation is complete, use Device Manager to determine the com port. To get to 
Device Manger, go to the Windows Control Panel, click on System, click on the Hardware tab, 
then click on Device Manager. Go down the device list and click on Ports (COM & LPT) and 
USB serial port (com #). Note the com port # for use with communications to your meter, then 
exit Control Panel. If you later need to change the Com port, right-click on USB serial port 
(com #), then on Properties, Port settings, and Advanced. Change port to the desired number, 
click OK, then exit Control Panel. 

A USB-to-RS485 gateway board allows a meter to be interfaced to a computer and be the 
device server for a network of up to 31 other meters on an RS485 bus, while itself retaining all 
capabilities of a meter. The remote meters need to be equipped with our RS485 digital 
interface board with dual 6-pin RJ11 jacks, not our RS485 digital interface with dual 8-pin RJ45 
jacks. The dual 6-pin RJ11 jacks on the RS485 board are wired in parallel to allow multiple 
meters to be daisy-chained using readily available 6-wire data cables with no need for hand-
wiring or an RS485 hub. The outer two wires are used for ground. 

Use 6-wire, straight-through data cables, P/N CBL03, not 4-wire telephone cables or 
crossover cables, all the way from the device server to the last device on the RS485 bus. 
Connect ATX to ATX, BTX to BTX, etc., with no crossover as you go from device to device. 
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BOARD SETUP VIA JUMPERS 

USB Board (P/N LUSB) 

No jumpers required. 

 

RS232 Board (P/N L232) 

e -  Do not use (except for externally enabled RTS). 
Prevents use of Instrument Setup PC software. 

f -  Do not use.  
     g -  Installed for normal operation. 

Note:  Board is shipped with jumper g installed.  

RS485 Board, RJ11, P/N L485, Full Duplex Operation 

b & d - Installed on last meter in long cable run. 

RS485 Board, RJ11, P/N L485, Half Duplex Operation 

a & c - Installed for half duplex operation. 
d - Installed on last meter in line with long cable runs. 

Note:  Board is shipped with no jumpers installed.  

RS485 Board, RJ45, P/N LMOD, Full Duplex Operation 

b & e - Bias jumpers should be installed on 1 board. 
a & d - Installed on last meter in long cable run. 

RS485 Board, RJ45, P/N LMOD, Half Duplex Operation 

b & e - bias jumpers installed on 1 board. 
c & f - installed for half duplex operation. 
a - installed on last meter in line with long cable runs. 

Note:  Board is shipped with no jumpers installed. 

Modbus

ba

cd
e

RJ45

RJ45

f
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SERIAL CONNECTION EXAMPLES 
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KEYSTROKES FOR SETUP 
If the MENU    key does not work, see Section 10 “Enabling & Locking Out Menu Items.” 
 

  

Press Menu 
Select Key 

 
  

Press Digit Select 
Key 

 
  

Press Value Select 
Key 

 

.SEr 1. 
Fixed Parameters: 
No parity 
8 data bits 
1 stop bit 

__000 
Output signal source 

0   Send unfiltered value 
1   Send filtered value 

__000U 
Baud rate 

0   300 baud 
1   600 baud 
2   1200 baud 
3   2400 baud 
4   4800 baud 
5   9600 baud 
6   19200 baud 

__000U 
Output update rate for 
continuous mode 

     60 Hz  50 Hz 
0   Line frequency Line frequency 
1   0.28 sec  0.34 sec 
2   0.57 sec  0.68 sec 
3   1.1 sec  1.4 sec 
4   2.3 sec  2.7 sec 
5   4.5 sec  5.4 sec 
6   9.1 sec  10.9 sec 
7   18.1 sec  21.8 sec 
8   36.6 sec  43.5 sec 
9   72.5 sec  97 sec 
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Press Menu 
Select Key 

 
  

Press Digit Select 
Key 

 
  

Press Value Select 
Key 

 

.SEr 2. 
Serial Setup 2 

_0000U 
Line feed 

0   No line feed after carriage return 
1   Line feed after carriage return 

_0000U 
Alarm data with readings 

0   No alarm data 
1   Alarm data with reading 

_0000U 
Control of data output 

0   Continuous data output 
1   Data output on command only 

_0000U 
Meter address with Custom 
ASCII protocol 

Select 1 thru F for addresses 1 thru 15. 
Select 0. thru F. (with decimal point) for 
addresses 16 thru 31. 

.SEr 3. 
Serial Setup 3 

00000U 
Half or full duplex 

0   Half or full duplex 
1   Do not use 

00000U 
Special start & stop char. 

0   Standard continuous mode 
1   Special start & stop characters 

00000U 
RTS mode 

0   Normal RS232 operation 
1   Single RS232 transmission mode 
     with -e jumper on RS232 board 

00000U 
Termination characters 

0   Only at end of all items 
1   At end of each item 

00000U 
Data sent in continuous 
mode 

0   Net + gross 
1   Net only 
2   Gross only 
3   Peak only 
4   Net + gross + peak 

SEr 4. 
Serial Setup 4. 

__000U 
Modbus ASCII gap timeout 

0   1 sec 
1   3 sec 
2   5 sec 
3   10 sec 

__000U 
Serial protocol 

0   Custom ASCII, 8 bits, no parity 
1   Modbus RTU, 8 bits 
2   Modbus ASCII, 7 bits 

__000U 
Parity 

0   None, 2 or more stop bits 
1   Odd, 1 or more stop bits 
2   Even, 1 or more stop bits 

_Addr 
Modbus Address. 
Appears only if the 
Modbus protocol is 
selected. 

__000   __000   __000 
Select digit to flash. 

__247 
Select 0 through 9 for flashing digit. 
Address range is 1 to 247. 
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17.  EXCITATION OUTPUT & POWER SUPPLY 

 
Three isolated transducer excitation output levels are available from the power supply board. 
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated. 
In addition, the board provides three jumper positions for special features. The same jumper 
locations apply to the universal power supply (85-264 Vac) and to the low voltage power 
supply (12-32 Vac or 10-48 Vdc). 
 

 
 
 

Excitation output Jumper locations 

5 Vdc ±5%, 100 mA max 

10 Vdc ±5%, 120 mA max 

24 Vdc ±5%, 50 mA max 

b, d, e 

b, d, f 

c 
 

 
 
SELECTION OF OTHER JUMPERS 
 

Jumper  a - Front panel menu lockout, locked when installed. (See Section 10) 

Jumper  g - Provides +5V power output at P1-4 when installed. 

Jumper  h - Connects "Control Input 2" to P1-4 when installed. 



  31 

18.  INSTRUMENT SETUP VIA PC    

 

Instrument Setup software is a PC program which is much easier to learn than front panel 
programming. It is of benefit whether or not the meter is connected to a PC. With the meter 
connected to a PC, it allows uploading, editing and downloading of setup data, execution of 
commands under computer control, listing, plotting and graphing of data, and computer 
prompted calibration. With the meter unconnected to a PC, it provides quick selection of 
jumper locations and a printable display of menu selections for front panel setup. 

 
SOFTWARE INSTALLATION 

Download IS2*.exe onto your PC from the web or the distribution CD. Double-click on the 
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory, 
double-click on setup.exe, which will install the software on your PC.  
 

PREREQUISITES FOR CONNECTED USE 

1) PC with available Com port.  

2) Meter to be set up. 

3) Communication board in the meter. This board 
can be used for meter setup, then be removed. 

4) Cable to connect the meter and PC (see 
Section 1, Ordering Guide). 

5) Instrument Setup software. 
 
ESTABLISHING COMMUNICATIONS 

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run 
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs => 
IS2 => IS2. Click on RS232 and select the meter parameters. The program will temporarily 
set the selected Com port to the required baud rate, parity, data bits and stop bit. Once 
communications have been established, click on Main Menu. The software will sense the 
type of meter and installed boards, but it cannot sense jumpers positions nor set jumpers for 
you. If the computer is not connected to a meter, select DPM and Series 2. 
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SETUP OF CONNECTED METER 

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View => 
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup), 
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup 
files from a PC can be a major time saving when multiple meters have to be set up in the 
same way. 

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications, 
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not 
sensed, the corresponding tab will be grayed out. 
 

ADDITIONAL FEATURES 

  The Commands pull-down menu allows you to execute certain meter functions by using 
your computer mouse. You can reset individual meter functions, display current or peak 
readings, and enter numbers to be displayed remotely by the DPM. The first position of a 
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must 
be transmitted. Leading 0’s serve as blanks. The Commands pull-down menu will be grayed 
out unless a Get Setup has been executed. 
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Plot 

 

Graph 

  The Readings pull-down menu provides three formats to display DPM data on the PC 
monitor. Use the Pause and Continue buttons to control the timing of data collection, then 
press Print for a hardcopy using your PC printer. 

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any 
time to freeze the display. Press Print for a hardcopy. List can capture peak readings. 

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC 
combination into a printing digital oscilloscope. 

- Graph generates a histogram, where the horizontal axis is the reading and the vertical 
axis is the number of occurrences of readings. The display continually resizes itself as 
the number of readings increases. 

   The Jumpers pull-down menu provides 
jumper positions for the various meter 
boards, duplicating information in this 
manual. 

   The Calibration pull-down menu allows 
easy calibration of voltage and current 
ranges for the DC, load cell, and AC RMS 
signal conditioner boards. The PC first 
recognizes the type of board, then prompts 
you to apply specific jumpers and calibra-
tion signals. Press Ready to take a read-
ing. Press Repeat to take more readings. 
When you have decided on which reading 
to accept, press on the number 1 through 10 of that reading. Additional calibration software 
is available online. 

METER SETUP WITH AN UNCONNECTED PC 

Instrument Setup software is also of benefit when the PC is not connected to a meter. Upon 
launching the software, click on None for Communications, then on DPM and Series 2. Click 
on File => Default Setup to retrieve a default setup file from disk, or on File => Open Setup 
to retrieve a previously saved setup file from disk.  
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To enter new setup information, click on View => Setup, then make your screen selections 
as if you were connected to a meter. Tabs will be grayed out if you have not selected the 
required hardware under the Input+Display tab. When 
done, press on Main Menu, then on View => Menu. 
The selections made under Setup will now be shown 
in the form of the required front panel programming se-
quence, where each row corresponds to a menu item 
selected by the  key, and the seven data columns 
correspond to values entered via the  and  keys.  

Click on any step in the sequence to bring up a 
detailed help window. 

Click on Print for a hardcopy, which you can then use 
as an instruction sheet to program your meter via its 
front panel. 

Click on Main Menu => File => Save Setup As to save 
your setup to disk and have an electronic record.  
 

 

 

19.  SCALE METER CALIBRATION   

 
All analog input and analog output ranges of the meter have been digitally calibrated at the 
factory prior to shipment using calibration equipment certified to NIST standards. Calibration 
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner 
board and analog output board. As a result, these boards may be changed without requiring 
meter recalibration. 

If recalibration is required, the meter may be returned to the factory or to any authorized 
distributor. Easy calibration of DC and load cell signal conditioner ranges is possible using our 
Instrument Setup software. To allow computer aided calibration, an RS232 or RS485 interface 
card must be installed in the meter. This card may be installed temporarily and be removed 
following calibration. Step-by-step instructions and advanced calibration software are available 
from the factory. 
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20.  SCALE METER SPECIFICATIONS   

 
Meter Display 

Type .................................... 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators 
Color .................................................................................................................... Red or green 
Range .................................................................... -99999 to +99999 and -99990  to  +99990 

A to D Conversion 

Technique (Pat.5,262,780) ........................................................................ Concurrent SlopeTM 
Read Rate ............................................................... 60/s for 60 Hz NMR, 50/s for 50 Hz NMR 
Output Update Rate .....................................................................56/s at 60 Hz, 47/s at 50 Hz 
Display Update Rate .................................................................... 3.5/s at 60 Hz, 3/s at 50 Hz 

Noise Rejection 

CMV from DC to 60 Hz ................................................................................ Withstand 250Vac 
Dielectric strength ....................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 
CMR from DC to 60 Hz ................................................................................................ 130 dB 
NMR at 50/60 Hz ............................................................... 90 dB with minimum digital filtering  

Control Inputs (CMOS/TTL levels, logic 0 = tied to digital ground, logic 1 = open) 

/ Hold input .......................................................................... Logic 0 holds display and outputs 
/ Peak ........................................................................................... Logic 0 displays peak value 
/ Tare .................................................................................. Logic 0 offsets input value to zero 
/ Tare Reset.......................................................................... Logic 0 resets Tare value to zero 
/ Meter Reset ....................................................................... Logic 0 resets all meter functions 
/ Function Reset .......................................................... Logic 0 resets peak values and alarms 
/ Display Blank ..............................................................................Logic 0 shuts off the display 
/ Display Item............................................................................. Logic 0 displays Gross  value 

Power Requirements 

Input Voltage rating (standard) ......... 85-264 Vac or 90-300 Vdc (DC range not UL approved) 
Input Voltage rating (low voltage option) ............................................ 12-32 Vac or 10-48 Vdc 
Power Line Frequency ................................................................................. DC and 47-63 Hz 
Power Consumption, Max ........................................................................................... 5 Watts 

Excitation Outputs 

Voltage & Current Levels (jumper selectable) .................................. 5 Vdc ±5%, 100 mA max 
 ....................................................................................................... 10 Vdc ±5%, 120 mA max 
 ........................................................................................................ 24 Vdc ± 5%, 40 mA max 
Excitation Output Ripple ..................................................................................... 100 mVp max 
Isolation from power and outputs ............................................................................... 250 Vac 
Insulation dielectric strength to power and outputs ..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 
Isolation to signal common ........................................................................................... 50 Vdc 
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DC, Process, Strain Signal Conditioner 

Range Resolution Resistance Zero Range Span Range Error 

200.00 mV 
2.0000 V 
20.000 V 

10 µV 
100 µV 
1 mV 

1 GΩ 
-99999 to 

99999 
0 to ±99,999 

0.01% of FS 
±2 cts at 25°C 

Load Cell Signal Conditioner 

Range Resolution Resistance Zero Range Span Range Error 

20.000 mV 
50.000 mV 
100.00 mV 
250.00 mV 
500.00 mV 

1 µV 
2.5 µV 
5 µV 

12.5 µV 
25 µV 

1 GΩ 
-99999 to 

99999 
0 to ±99,999 

0.01% of FS 
±2 cts at 25°C 

Dual Relay Options 

Power to Relay Option ................................................................................ Powered by meter 
Setpoint Setup ....................................................... Via front panel pushbuttons or RS232/485 
Update Rate .................................................................................56/s at 60 Hz, 47/s at 50 Hz 
Response to input signal (min) .................................................................. Display update rate 
Input Signal (selectable) ...................................... Net, Gross, filtered or unfiltered input signal 
Actuation Modes (selectable) ...... Above or below setpoint, latching or non-latching, disabled 
Output Time Delay (selectable) .................................................................... 1 to 128 readings 
Front Panel Enable / Lockout Modes (selectable) ................ 1)  Display and change setpoints 
 ................................................................................... 2)  Display but do not change setpoints 
 .................................................................................. 3)  Neither display nor change setpoints 
Alarm Status Indication ................................................................................. 2 red LED lamps 
Status Indication Setup (selectable) ....................... Lit when output is ON or OFF, or disabled 

Form C, SPDT Relay Output: 

AC Rating ......................................................................................................... 8A @ 240 Vac  
DC Rating ........................................................................................................... 8A @ 24 Vdc 
Isolation rating between signal common and contacts ............................................... 250 Vac 
Insulation dielectric strength between signal common and contacts ........................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 

Form A, SPST Solid State Relay Output: 

AC Rating .................................................................................................. 130 mA @ 140 Vac 
DC Rating .................................................................................................. 130 mA @ 180 Vdc 
Isolation rating between signal common and contacts ............................................... 250V ac 
Insulation dielectric strength between signal common and contacts ........................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 

Analog Output Option 

Power to Analog Output Option ................................................................... Powered by meter 
Output Levels ..............................................................0-20 mA, 4-20 mA, 0-10V, -10 to +10V 
Voltage Compliance, 0-20 mA Output .................................................. 12V (0-600 Ohm load) 
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Current Compliance, 0-10V, -10 to +10V Output ....................... 2 mA (5 kOhm or higher load) 
Accuracy .......................................... Meter input accuracy ±0.02% of full scale analog output 
Resolution ........................................................................................... 16 bit (1 part in 65,536) 
Response Time ....................................................................................... 50/60Hz update rate 
Scaling of Reading for Zero Output ............................................................-99,999 to +99,999 
Scaling of Reading for Full Scale Output ................................................... -99,999 to +99,999 
Isolation rating between signal common and analog output ....................................... 250V ac 
Insulation dielectric strength between signal common and analog output ................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 

Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards) 

Output Types ........................ RS232, RS485, RS485-Modbus, USB, USB-to-RS485 gateway  
Power to Interface Option ............................................................................ Powered by meter 
RS485 Wiring ............................................................................................... Half or full duplex 
Baud Rates ............................................................ 300, 600, 1200, 2400, 4800, 9600, 19200 
Serial Protocols ...................................................... Custom ASCII, Modbus RTU (selectable) 
Signal Levels ................................................................. Meet RS232, RS485, USB standards 
Isolation rating between signal common and serial I/O .............................................. 250V ac 
Insulation dielectric strength between signal common and serial I/O .......................................  
 ................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min 
Option Board Connectors: 
     RS232  ..................................................................................................... Single RJ11 jack 
     RS485 ................................... Two RJ11 jacks (for daisy chaining with 6-wire data cables) 
     RS485 Modbus ...................... Two RJ45 jacks (for daisy chaining with 8-wire data cables) 
     USB .......................................................................................................... USB type B plug 
     USB-to-RS485 gateway .............................USB type B plug plus RJ11 jack to RS485 bus 

Environmental 

Operating Temperature ......................................................................................... 0°C to 55°C 
Storage Temperature ........................................................................................ -40°C to 85°C 
Relative Humidity ...................................................... 95% from 0°C to 40°C, non-condensing 
Case ............................ NEMA-4X (IP65) from front when panel mounted (not verified for UL) 
Shock ........................................................................... 10 G at 1 kHz, applied in X, Y, Z axes 
Vibration ............................................. 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.  
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21.  GLOSSARY OF TERMS 

 
Adaptive Filter Threshold 
 A threshold which causes an adaptive moving average filter to be reset to the 

latest reading when the accumulated difference between individual readings 
and the filtered reading exceeds that threshold. Adaptive moving average 
filtering allows a meter to respond rapidly to actual changes in signal while 
filtering out normal noise. The accumulated difference is also reset to zero 
when the latest reading has a different polarity than the filtered reading. A low 
adaptive filter threshold is normally selected. A high filter threshold should be 
selected if the signal has large transients. 

Alarm, Latched 
 An alarm which stays actuated until reset. 

Latched alarms can shut down machinery or 
a process when an operating limit has been 
exceeded, or maintain an alarm condition 
until acknowledged by an operator. 

Alarm, Non-latched 
 An alarm which changes state automatically 

when the reading rises above a specified limit 
and changes back automatically when the 
reading falls below a limit. 

Autofilter  A selectable digital filter mode which auto-
matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6 
sec for the encountered noise condition. 

Auto-tare A selectable meter operating mode, where 
the first reading following power-on or meter 
reset is used to zero the display. Further 
readings are then relative to this new zero. 

Auto-zero An auto-zero limit from 0 to 9 counts can be programmed to compensate for 
load cell drift. Whenever the meter comes to rest within that limit from zero, it 
will auto-zero. Auto-zero can be enabled or disabled. 

Batch Average Filter 
 A digital filter mode which averages 16 readings and then displays the average. 

Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power. 

Counts The reading displayed on the panel meter ignoring the decimal point. 

Count-by A settable scale meter parameter which allows readings to be rounded to 1, 2, 
5, 10, 20, 50 or 100 counts. For example, set the count-by to 10 to read weight 
to the nearest 1 lb if each count is 0.1 lb. 
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Custom ASCII Protocol 
 A simplified, short protocol for use with these panel meters. It allows 31 digital 

addresses. Not an industry-standard protocol, like the more complex Modbus 
protocol, which is also offered with the meters. 

Display Blank A rear panel input which blanks the display when the input is tied to logic 
ground by a switch or 0V is applied (logic level true). The meter display will light 
when the input is open or is held at +5V (logic level false). 

Dribble A settable scale meter parameter in counts 
which allows a flow to be shut off before the 
setpoint value has been reached. For exam-
ple, set the setpoint to 100.0 (1000 counts) 
and the dribble factor to -50 counts to turn off 
the fill of a 100.0 lb bag at 95.0 lbs if the shut-
off system is known to dribble another 5.0 lbs 
following shut-off. 

Full Scale The maximum input signal range for which 
the meter has been configured. For example, 
the most sensitive full scale for the load cell meter is ±20 mV (signal range from 
-20 mV to +20 mV). 

Function Reset 
 A rear panel control input which resets Peak, Valley and any latched alarms 

when the input is tied to logic ground by a switch or 0V is applied (logic level 
true). To reset the value again, the input must be open or 5V applied (logic 
level false) and then set low. 

Ground Loop A closed conductive path in external ground wiring that allows stray currents to 
flow in ground wiring, creating ground noise. The meters in this manual 
minimize ground loop problems by mutually isolating the grounds associated 
with meter power, signal input, and all output and communication options. 

Jumper A push-on component which provides a short between two adjacent posts on a 
circuit board. For example, jumpers are used to configure signal conditioner 
boards for different signal types and full-scale ranges. Unused jumpers are 
stored by pushing one side over an unused post. 

Hysteresis Band 
 A band which controls relay action symmetrically around a setpoint. The relay 

closes (or opens) when the reading goes above the setpoint plus one hyste-
resis limit, and opens (or closes) when the reading falls below the setpoint less 
one hysteresis limit. A narrow hysteresis band is often used to minimize relay 
chatter around a setpoint due to electrical noise or signal feedback caused by 
load switching. A wide hysteresis band can be used for control applications, 
such as turning on a fill pump when the tank level has reached a lower limit and 
shutting off the pump when the tank level has reached an upper limit. The 
hysteresis band will be equal to two hysteresis limits. 
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Menu Mode The meter programming mode used for input and range selection, meter setup, 
and meter configuration. Entered into from the Run mode by pressing the 
MENU key. The Menu mode can be locked out completely by a jumper. 

Meter Hold A rear panel input which freezes the meter display and all meter outputs while 
that input is tied to logic ground by a switch or is held at 0V (logic level true). 
The meter will resume operation when the input is allowed to float or is held at 
+5V (logic level false).  

Modbus An industry-standard serial communications protocol which allows devices by 
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the 
Custom ASCII protocol, which is also supported by these meters. 

Moving Average Filter 
 A digital filter mode which displays a weighting moving average of readings. 

Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power. 
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz 
power. There are eight moving average modes: 

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant). 

Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant). 

Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant). 

Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant). 

Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant). 

Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant). 

Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant). 

Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant). 

Offset A constant adder used for the displayed reading. This is the term b in the 
straight line formula y =  mx + b, where y is the displayed reading in counts, m 
is the scale factor, x is the measured reading in counts, and b is the offset. For 
direct readout in (milli)volts or (milli)amps, offset is 0. 

Peak Display The maximum (or most positive) reading since that maximum was last reset. 
Reset can be via the meter front panel, an external input, or a software 
command. The displayed value can reflect the filtered or unfiltered readings. 

Process Signal 
 A signal whose display requires setup of scale and offset settings for display in 

engineering units. A classical process signal is 4-20 mA, where the 4 mA and 
20 mA end points can each correspond to a desired meter reading. 

Reading The value displayed by the meter. “Taking a reading” is the action of the meter 
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60 
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of 
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power. 

Remote Display 
 A display mode which allows the meter to serve as a remote display to another 

meter when connected to it by a 4-wire phone cord. Also allows the meter to 
transmit raw measurement data to a computer and then display processed data 
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from the computer. A serial communications option board is required in the 
meter. If such a board is not installed or no serial data is received, the meter 
displays rESEt. 

Reset There are three types of Reset: 
 Peak Reset. Achieved by simultaneously pressing the RESET and PEAK 

keys. 
 Latched Alarm Reset. Achieved by simultaneously pressing the RESET and 

ALARMS keys. 
 Meter Reset. Causes the meter to reinitialize and take a tare reading when 

set up for auto-tare. Achieved powering up the meter, by pressing the 
RESET and MENU keys simultaneously, stepping through all top-level 
menu choices, grounding a rear panel connector, or supplying an ASCII 
command. rESEt is displayed briefly. 

RS485 Half Duplex 
 Serial communications implemented with two wires, allowing data transmission 

in both directions, but not simultaneously. 

RS485 Full Duplex 
 Serial communications implemented with four wires, allowing data transmission 

in two directions simultaneously. 

Run Mode The normal operating mode of the meter, 
where readings are taken, as opposed to the 
menu mode. 

Scale A constant multiplier used to go from A/D 
converter counts to displayed counts. This is 
the slope term m in the straight line formula  
y =  mx + b, where y is the displayed reading 
in counts, m is the scale factor, x is the 
measured reading in counts, and b is the 
offset. For direct readout in (milli)volts or 
(milli)amps, scale is 1. 

Scaling The process of setting scale and offset so that the meter reads properly in 
engineering units (such as psi).  

Scaling, Coordinates of 2 Points Method 
 A scaling method where four numbers are entered manually: low input, desired 

reading at low input; high input, and desired reading at high input. The meter 
then applies a straight line fit. The decimal point is set by the separate dEC.Pt 
menu item. 

Scaling, Scale and Offset Method 
 A scaling method where scale and offset are entered manually. 

Scaling, Reading Coordinates of 2 Points Method 
 A scaling method, where the low and high input values are determined from 

actual signals. A known low signal is first applied to the meter, such as the 
output of a pressure transducer at zero pressure. That signal is captured as the 
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low input value, and the desired low reading is entered. A known high signal is 
then applied, such the output of a transducer for a know weight or pressure. 
That signal is captured as the high input value, and the desired high reading is 
entered. The meter then applies straight line fit. This scaling method has the 
advantage of calibrating the transducer and meter as a system. The actual 
voltage or current at either point does not need to be known. The decimal point 
is set by the separate dEC.Pt menu item. 

Setpoint A value compared to the reading to determine the state of a relay. Term often 
used interchangeably with “alarm setpoint.” The relay action can by latching or 
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis 
bands and deviation bands are specified by two symmetrical limits around the 
setpoint.  

Span The number of counts corresponding to a given signal range. 

Tare A rear panel input which causes the display to be set to zero when the input is 
momentarily tied to logic ground by a switch or is held at 0V (logic level true) for 
a minimum of 50 ms. When the input is allowed to float or is held at +5V (logic 
level false), the meter displays readings relative to this new zero. A common 
application is in weighing, where an external Tare button is pressed to read the 
weight of an empty scale (tare), and tare is then automatically subtracted as a 
constant from gross weight for display of net weight. Tare can also be used for 
other applications where a reading relative to starting point is desired. 

Zero When used with process meters, zero is an adjustment so that a given low 
transducer output reads zero on the meter. Zero is adjusted by programming 
offset. 
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22. WARRANTY

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for 
a period of one year from the date of purchase.   

In the event of a defect during the warranty period, the defective unit may be returned to the 
seller, which may be Laurel or a Laurel distributor. The seller may then repair or replace the 
defective unit at its option. In the event of such a return, freight charges from the buyer shall 
be paid by the buyer, and freight charges from the seller shall be paid by the seller. 

LIMITATION OF WARRANTY 

The foregoing warranty shall not apply to defects resulting from: 

1. Improper installation or miswiring.
2. Improper or inadequate maintenance.
3. Unauthorized modification or misuse.
4. Operation outside the environmental specifications.
5. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is 
expressed or implied. Laurel specifically disclaims implied warranties of merchantability and 
fitness for a particular purpose. 

Any electronic product may fail or malfunction over time. To minimize risks associated with 
reliance on Laurel products, users are expected to provide adequate system-level design 
and operating safeguards. Laurel’s products are intended for general purpose industrial or 
laboratory use. They are not intended nor certified for use in life-critical medical, nuclear, or 
aerospace applications, or for use in hazardous locations. 

EXCLUSIVE REMEDIES 

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall 
Laurel be liable for direct, indirect, incidental or consequential damages (including loss of 
profits) whether based on contract, tort, or any other legal theory. 

Copyright 1993-2021 Laurel Electronics, LLC  27 October 2021


